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CONHECIMENTOS GERAIS 
 

LÍNGUA PORTUGUESA 
 
 
 Leia o texto adaptado abaixo para responder às questões 

1 e 2. 
 
Caçada por submarino evoca tempos da Guerra Fria 

para Suécia e Rússia 
 

Suecos lançaram operação para localizar embarcação invasora em 
suas águas; russos negam envolvimento no caso e apontam para a 

Holanda 
 

Um submarino estrangeiro detectado no arquipélago de 

Estocolmo provocou a maior mobilização militar na Suécia 

desde a Guerra Fria, envolvendo o deslocamento emergencial 

de soldados, embarcações e helicópteros. Nesta segunda-feira, 

uma zona fechada para voos foi declarada na área de buscas. 

Os primeiros alertas começaram a soar na sexta-feira e a 

suspeita logo recaiu sobre a Rússia, que negou envolvimento 

no caso e ainda apontou para a Holanda. “É um submarino de 

propulsão diesel-elétrica holandês Bruinvis que, na semana 

passada, realizava exercícios bem perto de Estocolmo”, afirmou 

uma fonte do Ministério da Defesa russo. 

Só que o porta-voz do ministério holandês da Defesa, 

Marnoes Visser, também negou sua participação. “O submarino 

holandês não está envolvido e nós não estamos envolvidos nas 

operações de busca lançadas pelas forças suecas”, declarou. 

“Participamos em manobras com a Suécia e outros navios, mas 

elas terminaram na terça-feira da semana passada”. 

Nas últimas semanas, a Suécia vem apontando uma série 

de invasões ao seu espaço aéreo por parte de aviões russos, 

esfriando as relações entre os dois países. Sobre o submarino, 

especificamente, as autoridades suecas limitaram-se a afirmar 

que receberam um alerta sobre “atividade submarina 

estrangeira” no litoral. O primeiro-ministro Stefan Löfven disse 

que, por enquanto, as missões lançadas pela Marinha são 

apenas para “coletar informações”. 

Segundo uma reportagem do jornal Svenska Dagbladet 

publicada no fim de semana, o serviço secreto sueco 

interceptou frequências de rádio em uma área entre o litoral de 

Estocolmo e o enclave russo de Kaliningrado, onde está 

localizada grande parte da frota russa no Mar Báltico. 

A situação expõe a preocupação crescente sobre as 

intenções de Vladimir Putin na região. Em pouco mais de um 

mês, surgiram informações sobre um agente de inteligência da 

Estônia que teria sido levado por forças russas, a Finlândia 

reclamou da interferência de Moscou em um de seus navios de 

pesquisa e a Suécia fez um protesto formal sobre uma “grave 

violação” quando caças russos entraram em seu espaço aéreo. 

“Isso pode se tornar um divisor de águas para a 

segurança em toda a região do Mar Báltico”, escreveu o 

chanceler letão, Edgars Rinkevics, em sua conta em uma rede 

social. Autoridades da Letônia apontaram um aumento na 

presença de submarinos e navios russos perto de suas águas 

territoriais. 

Histórico – Não é a primeira vez que um submarino 

provoca um estranhamento nas relações entre a Rússia e a 

Suécia. A caçada desta semana ao submarino misterioso evoca 

as rotineiras invasões das águas territoriais suecas por 

embarcações soviéticas durante os anos da Guerra Fria. 

No incidente mais notável, ocorrido em outubro de 1981, 

um submarino a diesel soviético acabou encalhando 

acidentalmente em uma praia sueca próxima de Karlskrona, 

onde está localizada a maior base naval da Suécia. No 

momento mais tenso do episódio, navios de guerra soviéticos 

tentaram forçar passagem entre a marinha sueca para resgatar 

o submarino. No final, os esforços de intimidação não 

funcionaram e os soviéticos retrocederam. O episódio só 

acabou depois de dez dias de tensão, quando rebocadores 

suecos acabaram levando o submarino para águas 

internacionais, onde ele foi entregue aos soviéticos.   

Houve também alarmes falsos, ocasiões em que a Suécia 

pensou ter detectado submarinos quando, na verdade, os sinais 

haviam sido emitidos por lontras. 

 
http://veja.abril.com.br/noticia/mundo/cacada-por-submarino-provoca-

queda-de-braco-entre-russia-e-suecia 
 
1. De acordo com o texto, analise as assertivas abaixo. 
 

I. Na realidade, não houve a detecção de submarinos 
em nenhuma ocasião. Em todas as vezes, os sinais 
haviam sido emitidos por lontras. 

II. O submarino detectado em Estocolmo provocou 
grande mobilização militar na Suécia durante a 
Guerra Fria. 

III. Ainda que a Rússia negue envolvimento e aponte 
para a Holanda, a situação expõe a preocupação 
crescente sobre as intenções russas na região do 
Mar Báltico. 

 
 É correto o que se afirma em 
 

(A) I e II, apenas. 

(B) II e III, apenas. 

(C) III, apenas. 

(D) II, apenas. 

(E) I, II e III. 
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2. De acordo com a norma-padrão da Língua Portuguesa e 
quanto à acentuação, assinale a alternativa em que as 
palavras devam ser acentuadas, respectivamente, de 
acordo com as mesmas regras de acentuação das 
palavras apresentadas abaixo. 

 
Arquipélago/ notável/ inteligência 

 
(A) Sofa/ tambem/ violencia 

(B) Cronica/ acaraje/ pes 

(C) Armazem/ torax/ facil 

(D) Lagrima/ agradavel/ proverbio 

(E) Album/ pro/ jilo 
 

 
3. De acordo com a norma-padrão da Língua Portuguesa e 

quanto à ortografia, assinale a alternativa correta. 
 

(A) A evazão escolar aumentou em relação ao ano 
passado. 

(B) Exonerou-se desta responsabilidade, mas assumiu 
outras. 

(C) Os bandidos ficaram calados com medo de sofrer 
reprezálias. 

(D) Minha sogra está sofrendo com retensão de líquidos. 

(E) O diretor se opôs à recisão do contrato. 
 

 
4. De acordo com a norma-padrão da Língua Portuguesa e 

quanto à concordância verbal, assinale a alternativa 
correta. 

 
(A) Fui eu que pintei o muro da escola. 

(B) Perto de quinhentos alunos compareceu à cerimônia 
que homenageava a professora falecida. 

(C) Confiam-se em teses absurdas no que concerne à 
análise dos dados estatísticos. 

(D) Suponho ser eles os responsáveis pelas 
manifestações. 

(E) 25% quer a mudança na área da Educação. 
 

 
5. De acordo com a norma-padrão da Língua Portuguesa e 

quanto à ocorrência de crase, assinale a alternativa 
correta. 

 
(A) Quero falar à algumas pessoas a respeito da minha 

carreira. 

(B) Estamos à caminho do hospital. 

(C) Ele não estava disposto à testemunhar contra seu 
próprio pai. 

(D) Quero mostrar à você o quarto do meu filho. 

(E) A mulher à qual devo minha vida faleceu no ano 
passado. 

 
 
 
 
 
 
 

MATEMÁTICA/ RACIOCÍNIO LÓGICO 
 
 
6. Com o intuito de alavancar as vendas de carros, uma 

concessionária, no inicio do mês de dezembro, ofereceu 
um desconto de 5% nos preços de todos os seus 
automóveis. Os resultados de vendas não foram 
satisfatórios e os diretores resolveram, no final do mês, 
oferecer, em caráter promocional, um desconto de 15% 
sobre o preço já reduzido, mantendo, assim, uma ínfima 
margem de lucro. Se forem considerados o valor de um 
veículo no início do mês antes dos descontos e seu valor 
no final do mês após todos os descontos, verificar-se-á 
que o valor total de desconto neste mês foi de 

 
(A) 20%. 

(B) 19,25%. 

(C) 18,75%. 

(D) 18,25%. 

(E) 17,85%. 
 

 
7. Analise o gráfico abaixo. 
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 Assinale a alternativa que apresenta a única função que 

atende a esta representação gráfica. 
 

(A) )(.2)( xsenxf = . 

(B) )log()( xxf = . 

(C) 1)( 2
+= xxf . 

(D) )cos(2)( xxf −= . 

(E) 1)( += xxf . 

 
 

8. Considerando apenas os algarismos 0, 3, 5, 7 e 9, 
assinale a alternativa que apresenta a quantidade de 
números de 4 algarismos que podem ser formados que 
são múltiplos de 5. 

 
(A) 625. 

(B) 500. 

(C) 250. 

(D) 200. 

(E) 96. 
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9. Pedro comprou um terreno, conforme a figura abaixo, com 
unidades dadas em metros, e precisa cercá-lo para evitar 
que animais estraguem o solo que acabou de ser arado. 
Para a cerca, utilizará 4 fileiras de arame farpado em cada 
um dos lados. Diante do exposto, assinale a alternativa 
que apresenta a quantidade de arame que Pedro deverá 
comprar. 

 

 

 
(A) 248m. 

(B) 200m. 

(C) 124m. 

(D) 62m. 

(E) 50m. 
 

 
10. Um investidor aplicou R$200.000,00 durante 2 anos em 

uma modalidade de investimento que oferece juros 
simples de 2% a.m.. Diante do exposto, é correto afirmar 
que o rendimento total do investimento após este período 
foi de 

 
(A) R$202.000,00. 

(B) R$240.000,00. 

(C) R$268.000,00. 

(D) R$284.000,00. 

(E) R$296.000,00. 
 

 
INGLÊS BÁSICO 

 
 

Read the text below to answer the questions 11-15. 
 

NASA Researchers Studying Advanced Nuclear 
Rocket Technologies 

 
January 9, 2013 

 
By using an innovative test facility at NASA’s Marshall 

Space Flight Center in Huntsville, Ala., researchers are able to 

use non-nuclear materials to simulate nuclear thermal rocket 

fuels – ones capable of propelling bold new exploration missions 

to the Red Planet and beyond. The Nuclear Cryogenic 

Propulsion Stage team is tackling a three-year project to 

demonstrate the viability of nuclear propulsion system 

technologies. A nuclear rocket engine uses a nuclear reactor to 

heat hydrogen to very high temperatures, which expands 

through a nozzle to generate thrust. Nuclear rocket engines 

generate higher thrust and are more than twice as efficient as 

conventional chemical rocket engines. 

The team recently used Marshall’s Nuclear Thermal 

Rocket Element Environmental Simulator, or NTREES, to 

perform realistic, non-nuclear testing of various materials for 

nuclear thermal rocket fuel elements. In an actual reactor, the 

fuel elements would contain uranium, but no radioactive 

materials are used during the NTREES tests. Among the fuel 

options are a graphite composite and a “cermet” composite – a 

blend of ceramics and metals. Both materials were investigated 

in previous NASA and U.S. Department of Energy research 

efforts. 

Nuclear-powered rocket concepts are not new; the United 

States conducted studies and significant ground testing from 

1955 to 1973 to determine the viability of nuclear propulsion 

systems, but ceased testing when plans for a crewed Mars 

mission were deferred. 

The NTREES facility is designed to test fuel elements and 

materials in hot flowing hydrogen, reaching pressures up to 

1,000 pounds per square inch and temperatures of nearly 5,000 

degrees Fahrenheit – conditions that simulate space-based 

nuclear propulsion systems to provide baseline data critical to 

the research team. 

“This is vital testing, helping us reduce risks and costs 

associated with advanced propulsion technologies and ensuring 

excellent performance and results as we progress toward further 

system development and testing,” said Mike Houts, project 

manager for nuclear systems at Marshall. 

A first-generation nuclear cryogenic propulsion system 

could propel human explorers to Mars more efficiently than 

conventional spacecraft, reducing crews’ exposure to harmful 

space radiation and other effects of long-term space missions. It 

could also transport heavy cargo and science payloads. Further 

development and use of a first-generation nuclear system could 

also provide the foundation for developing extremely advanced 

propulsion technologies and systems in the future – ones that 

could take human crews even farther into the solar system. 

Building on previous, successful research and using the 

NTREES facility, NASA can safely and thoroughly test simulated 

nuclear fuel elements of various sizes, providing important test 

data to support the design of a future Nuclear Cryogenic 

Propulsion Stage. A nuclear cryogenic upper stage – its liquid-

hydrogen propellant chilled to super-cold temperatures for 

launch – would be designed to be safe during all mission phases 
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and would not be started until the spacecraft had reached a safe 

orbit and was ready to begin its journey to a distant destination. 

Prior to startup in a safe orbit, the nuclear system would be cold, 

with no fission products generated from nuclear operations, and 

with radiation below significant levels. 

“The information we gain using this test facility will permit 

engineers to design rugged, efficient fuel elements and nuclear 

propulsion systems,” said NASA researcher Bill Emrich, who 

manages the NTREES facility at Marshall. “It’s our hope that it 

will enable us to develop a reliable, cost-effective nuclear rocket 

engine in the not-too-distant future." 

The Nuclear Cryogenic Propulsion Stage project is part of 

the Advanced Exploration Systems program, which is managed 

by NASA’s Human Exploration and Operations Mission 

Directorate and includes participation by the U.S. Department of 

Energy. The program, which focuses on crew safety and mission 

operations in deep space, seeks to pioneer new approaches for 

rapidly developing prototype systems, demonstrating key 

capabilities and validating operational concepts for future vehicle 

development and human missions beyond Earth orbit. 

Marshall researchers are partnering on the project with 

NASA’s Glenn Research Center in Cleveland, Ohio; NASA’s 

Johnson Space Center in Houston; Idaho National Laboratory in 

Idaho Falls; Los Alamos National Laboratory in Los Alamos, 

N.M.; and Oak Ridge National Laboratory in Oak Ridge, Tenn. 

The Marshall Center leads development of the Space 

Launch System for NASA. The Science & Technology Office at 

Marshall strives to apply advanced concepts and capabilities to 

the research, development and management of a broad 

spectrum of NASA programs, projects and activities that fall at 

the very intersection of science and exploration, where every 

discovery and achievement furthers scientific knowledge and 

understanding, and supports the agency’s ambitious mission to 

expand humanity’s reach across the solar system. The NTREES 

test facility is just one of numerous cutting-edge space 

propulsion and science research facilities housed in the state-of-

the-art Propulsion Research & Development Laboratory at 

Marshall, contributing to development of the Space Launch 

System and a variety of other NASA programs and missions. 

 
Available in: http://www.nasa.gov 

 
 
 
 
 
 
 
 

11. Considering the text, read the statements below. 
 

I. Engines powered by expanded hydrogen work better 
than regular chemical engines. 

II. A CERMET composite is made of ceramics, metal 
and graphite. 

III. The Nuclear Cryogenic Propulsion Stage created the 
technology that took human crews to Mars. 

 
 According to the text, the correct assertion(s) is(are) 
 

(A) I and II, only. 

(B) I, II and III. 

(C) I and III, only. 

(D) I, only. 

(E) II, only. 
 

 
12. According to the text, one of the NASA’s Marshall Space 

Flight Center cutting-edge research facility is called 
 

(A) Space Launch System. 

(B) Nuclear Thermal Rocket Element Environmental 
Simulator. 

(C) Advanced Exploration Systems. 

(D) Nuclear Cryogenic Propulsion Stage. 

(E) Human Exploration and Operations Mission 
Directorate. 

 
 

13. Read the excerpt below taken from the text. 
 

“The program, which focuses on crew safety and mission 

operations in deep space, seeks to pioneer new approaches for 

rapidly developing prototype systems, demonstrating key 

capabilities and validating operational concepts for future vehicle 

development and human missions beyond Earth orbit.” 

 
 Choose the alternative that presents the words that best 

substitutes, respectively, the bold and underlined ones in 
the sentences above. 

 
(A) drops/ with 

(B) tackles/ within 

(C) tries/ outside 

(D) brings/ inside 

(E) travels/ behind 
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14. Consider the verb tense in the following sentence taken 
from the text.  

 
“Nuclear-powered rocket concepts are not new.” 

 
 Choose the alternative in which the extract is in the same 

verb tense as the one above. 
 

(A) “Nuclear rocket engines generate higher thrust […]”. 

(B) “[…] this test facility will permit engineers to design 
rugged, efficient fuel elements and nuclear 
propulsion systems […]”. 

(C) “[…] the United States conducted studies and 
significant ground testing from 1955 to 1973 […]”. 

(D) “A first-generation nuclear cryogenic propulsion 
system could propel human explorers to Mars more 
efficiently […]”. 

(E) “Both materials were investigated in previous NASA 
and U.S. Department of Energy research efforts.” 

 
 

15. Read the following sentence taken from the text. 
 

“Nuclear rocket engines generate higher thrust and are 

more than twice as efficient as conventional chemical rocket 

engines.” 

 
 It is correct to affirm that the adjectives in bold and 

underlined are, respectively,  
 

(A) comparative of inferiority and superlative. 

(B) superlative of superiority and comparative of 
inferiority. 

(C) superlative of equality and comparative of 
superiority. 

(D) comparative of superiority and superlative of 
inferiority. 

(E) comparative of superiority and comparative of 
equality. 

 
 

Read the text below to answer questions 16-20. 
 

Background 
 

The Naval Nuclear Propulsion Program (NNPP) started in 

1948. Since that time, the NNPP has provided safe and effective 

propulsion systems to power submarines, surface combatants, 

and aircraft carriers. Today, nuclear propulsion enables virtually 

undetectable US Navy submarines, including the sea-based leg 

of the strategic triad, and provides essentially inexhaustible 

propulsion power independent of forward logistical support to 

both our submarines and aircraft carriers. Over forty percent of 

the Navy's major combatant ships are nuclear-powered, and 

because of their demonstrated safety and reliability, these ships 

have access to seaports throughout the world. The NNPP has 

consistently sought the best way to affordably meet Navy 

requirements by evaluating, developing, and delivering a variety 

of reactor types, fuel systems, and structural materials. The 

Program has investigated many different fuel systems and 

reactor design features, and has designed, built, and operated 

over thirty different reactor designs in over twenty plant types to 

employ the most promising of these developments in practical 

applications. Improvements in naval reactor design have allowed 

increased power and energy to keep pace with the operational 

requirements of the modern nuclear fleet, while maintaining a 

conservative design approach that ensures reliability and safety 

to the crew, the public, and the environment. As just one 

example of the progress that has been made, the earliest 

reactor core designs in the NAUTILUS required refueling after 

about two years while modern reactor cores can last the life of a 

submarine, or over thirty years without refueling. These 

improvements have been the result of prudent, conservative 

engineering, backed by analysis, testing, and prototyping. The 

NNPP was also a pioneer in developing basic technologies and 

transferring technology to the civilian nuclear electric power 

industry. For example, the Program demonstrated the feasibility 

of commercial nuclear power generation in this country by 

designing, constructing and operating the Shipping port Atomic 

Power Station in Pennsylvania and showing the feasibility of a 

thorium-based breeder reactor. 

 
In:  Report on Low Enriched Uranium for Naval Reactor Cores. Page 1.                                                              

Report to Congress, January 2014.               
Office of Naval Reactors. US Dept. of Energy. DC 2058                       

http://fissilematerials.org/library/doe14.pdf 
 

16. According to the text, choose the alternative that presents 
how long can modern reactor cores stay without refueling. 

 
(A) 26 years. 

(B) 13 years. 

(C) Over 30 years. 

(D) Over 40 years. 

(E) Less than 13 years. 
 

 

17. Read the excerpt below taken from the text. 
 

“[…] because of their demonstrated safety and reliability, 

these ships have access to seaports throughout the world.” 

 
 Choose the alternative that presents the words that would 

better translate, respectively, the ones in bold and 
underlined. 

 
(A) segurança/ confiança 

(B) risco/ receio 

(C) cintos/ funcionalidade 

(D) pontes/ reatores 

(E) insegurança/ medo 
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18. Choose the alternative in which the bold and underlined 
word has the same grammar function as the one below. 

 
“The NNPP has consistently sought the best way to 

affordably meet Navy requirements by evaluating, developing, 

and delivering a variety of reactor types, fuel systems, and 

structural materials.” 

 
(A) Engineers are constantly searching for new 

discoveries. 

(B) The analysis of the reports is being reviewed. 

(C) Researchers improved the studies about nuclear 
power generation. 

(D) Technologies can be decisive to more advances in 
the nuclear power generation. 

(E) For their own safety, the submarines must have all 
equipments tested. 

 
 

19. According to the text, the Naval Nuclear Propulsion 
Program – NNPP 

 
I. investigates more efficient fuels and reactors for the 

Navy. 

II. is concerned about how to spend the financial 
resources received. 

III. has also contributed with the civilian power industry. 
 

The correct assertion(s) is(are) 
 

(A) I and III, only. 

(B) I and II, only. 

(C) III, only. 

(D) II and III, only. 

(E) I, II and III. 
 

 

20. Read the passage taken of the text below. 
 

“The Naval Nuclear Propulsion Program (NNPP) started in 

1948. Since that time, the NNPP has provided safe and 

effective propulsion systems to power submarines, surface 

combatants, and aircraft carriers. Today, nuclear propulsion 

enables virtually undetectable US Navy submarines, including 

the sea-based leg of the strategic triad, and provides essentially 

inexhaustible propulsion power independent of forward 

logistical support to both our submarines and aircraft carriers.” 

 
 Choose the alternative in which the words can properly 

substitute the ones in bold and underlined, respectively. 
 

(A) useless/ noticeable/ finite 

(B) operation/ target/ machine 

(C) effect/ detection/ exhaustion 

(D) efficient/ invisible/ endless 

(E) much/ little/ no 

ARQUITETO (CONHECIMENTOS ESPECÍFICOS) 
 
 
21. Considerando as diretrizes construtivas e as estratégias 

de condicionamento térmico passivo para adequação de 
uma edificação localizada no Rio de Janeiro, classificado 
como Zona Z8, segundo o Zoneamento Bioclimático 
Brasileiro, marque V para verdadeiro ou F para Falso e, 
em seguida, assinale a alternativa que apresenta a 
sequência correta. 

 

 
 

(   ) As sensações térmicas são melhoradas por meio da 
desumidificação dos ambientes. Esta estratégia 
pode ser obtida por meio da renovação do ar interno 
por ar externo através da ventilação dos ambientes.  

(   ) A ventilação cruzada é obtida por meio da circulação 
de ar pelos ambientes da edificação. Isto significa 
que se o ambiente tem janelas em apenas uma 
fachada, a porta deveria ser mantida aberta para 
permitir a ventilação cruzada. Também se deve 
atentar para os ventos predominantes da região e 
para o entorno, pois o entorno pode alterar 
significativamente a direção dos ventos.  

(   ) A forma, a orientação e a implantação da edificação, 
além da correta orientação de superfícies 
envidraçadas, podem contribuir para otimizar o seu 
aquecimento no período frio através da incidência de 
radiação solar. A cor externa dos componentes 
também desempenha papel importante no 
aquecimento dos ambientes por meio do 
aproveitamento da radiação solar.  

(   ) Nas situações em que a temperatura do ar estiver 
entre 21°C e 30°C, a umidificação do ar 
proporcionará sensações térmicas mais agradáveis. 
Essa estratégia pode ser obtida por meio da 
utilização de recipientes com água e do controle da 
ventilação, pois esta é indesejável por eliminar o 
vapor proveniente de plantas e atividades 
domésticas. 

 
(A) V/ V/ V/ V 

(B) V/ V/ F/ F 

(C) V/ V/ V/ F 

(D) F/ F/ F/ V 

(E) F/ V/ V/ F 
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22. Assinale a alternativa que apresenta as condições de 
conforto que são recomendadas para locais de trabalho 
onde são executadas atividades que exijam solicitação 
intelectual e atenção constantes, tais como: salas de 
controle, laboratórios, escritórios, salas de 
desenvolvimento ou análise de projetos. 

 
(A) O nível de ruído aceitável para efeito de conforto 

será de até 85dB (A) e a curva de avaliação de ruído 
(NC) de valor não superior a 80dB.  

(B) Índice de temperatura efetiva entre 20°C (vinte graus 
centígrados) e 23°C (vinte e três graus centígrados).  

(C) A velocidade do ar não poderá ser superior a 
0,35m/s.  

(D) A umidade relativa do ar não poderá ser inferior a 
60%. 

(E) Os parâmetros de conforto, tais como níveis de 
ruído, índice de temperatura efetiva, velocidade do 
ar e umidade relativa do ar devem ser medidos na 
altura do tórax do trabalhador.  

 
 

23. Considerando as abordagens no processo de desenho 
elaborado no software de projeto de construção AutoCAD 
Revit, marque V para verdadeiro ou F para falso e, em 
seguida, assinale a alternativa que apresenta a sequência 
correta. 

 
(   ) Se o processo de desenho foi iniciado usando outro 

programa de CAD (como o AutoCAD), será possível 
importar os dados existentes. O Revit importa 
diversos formatos CAD, incluindo os arquivos DWG, 
DXF, DGN e ACIS SAT, assim como os arquivos 
SketchUp (SKP) e Industry Foundation Classes 
(IFC).  

(   ) É possível iniciar um projeto ao desenhar um modelo 
conceitual. Após ter criado as formas básicas com 
as ferramentas de massa, pode-se converter faces 
de massa para elementos de construção.  

(   ) Ao importar um arquivo para o Revit, o formato de 
arquivo importado pode dar suporte a diferentes 
qualidades de geometria. Por exemplo, a 
renderização de uma imagem requer geometria 
volumétrica. 

(   ) Um modelo estrutural é fornecido com a instalação 
do Revit Structure. Neste modelo, as propriedades e 
faixas da vista foram modificadas para trabalhar com 
componentes estruturais. Embora seja possível 
trabalhar com componentes estruturais em projetos 
com base em modelos não estruturais, é preciso 
modificar as faixas da vista para exibir os 
componentes estruturais na vista. Isto acontece 
porque os componentes estruturais como vigas e 
pilares são colocados no nível abaixo da vista em 
que se está trabalhando.  

 
(A) V/ V/ V/ V 

(B) V/ V/ F/ V 

(C) V/ V/ V/ F 

(D) F/ F/ F/ V 

(E) F/ V/ V/ F 
 
 

24. Assinale a alternativa que apresenta a(s) escala(s) 
recomendada(s) para representação de desenhos de 
plantas, cortes e fachadas de projetos executivos 
arquitetônicos residenciais. 

 
(A) Escala 1:50. 

(B) Escala 1:175.  

(C) Escala 1:500.  

(D) Escalas 1:200 e 1:250.  

(E) Escalas 1:10 e 1:5.  
 

 
25. Considerando a normatização aplicada aos tipos de linhas 

no desenho arquitetônico, marque V para verdadeiro ou F 
para falso e, em seguida, assinale a alternativa que 
apresenta a sequência correta. 

 
(...) As linhas de cotas (contínuas) devem ser firmes, 

definidas, com espessura igual ou inferior à linha de 
eixo ou coordenadas. 

(...) As linhas de projeção (traço e dois-pontos) são 
indicadas para representar projeções de pavimentos 
superiores, marquises, balanços etc.. Quando se 
tratar de projeções importantes, devem ter o mesmo 
valor que as linhas de contorno.  

(...) As linhas grossas e escuras (traço forte e dois-
pontos) são utilizadas para representar, nas plantas 
baixas e cortes, as paredes e todos os demais 
elementos interceptados pelo plano de corte.  

(...) As linhas finas e leves (contínuas) são utilizadas 
para representar linhas de eixo ou coordenadas.  

 
(A) V/ V/ V/ V 

(B) V/ V/ F/ V 

(C) V/ V/ F/ F 

(D) F/ F/ V/ V 

(E) F/ F/ F/ F 
 

 
26. Assinale a alternativa que não atende aos princípios 

gerais e à normatização referente ao dimensionamento e 
à colocação de cotas no desenho arquitetônico. 

 
(A) As cotas devem ser escritas sem o símbolo da 

unidade de medida (m, mm ou cm), acompanhando 
a direção das linhas de cota. 

(B) Qualquer que seja a escala do desenho, as cotas 
representam a verdadeira grandeza das dimensões 
(medidas reais). 

(C) As linhas de cota devem ser contínuas e os 
algarismos das cotas devem ser colocados acima da 
linha de cota sempre que possível no meio do trecho 
cotado. 

(D) Os ângulos serão medidos em graus, exceto nas 
coberturas e rampas que se indicam em 
porcentagem.  

(E) As cotas oblíquas devem acompanhar a linha de 
cota, traçada como continuação de linha da figura do 
desenho. 
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27. Considerando a representação dos elementos construtivos 
em projetos arquitetônicos, assinale a alternativa correta. 

 
(A) As portas são representadas em vista apenas pelo 

seu contorno; preferencialmente com quatro linhas 
paralelas em traço cheio e médio, quando forem 
dotadas de marco. Em corte, indica-se apenas o 
vão, com a visão da parede do fundo em vista (traço 
cheio e grosso). 

(B) Os cortes devem ser desenhados sempre na mesma 
escala, e as cotas colocadas na mesma posição da 
planta baixa. As portas e as janelas aparecem 
sempre abertas.  

(C) Ao utilizar a escala 1:200 ou outras similares que 
originem desenhos muito pequenos, torna-se 
impraticável desenhar as paredes utilizando dois 
traços, deve-se, portanto desenhar as paredes 
“cheias”. 

(D) Nos cortes, as paredes podem aparecer 
seccionadas ou em vista. No caso de paredes 
seccionadas, a representação é similar aos pisos em 
planta.  

(E) A simbologia para indicação de níveis nos cortes é a 
mesma da simbologia para indicação em planta, 
sempre indicados em METROS e acompanhados do 
sinal, conforme localizarem-se acima ou abaixo do 
nível de referência (00). Sempre são indicados com 
referência ao nível ZERO.  

 
 

28. Considerando o uso de biblioteca de blocos em desenho 
CAD, marque V para verdadeiro ou F para falso e, em 
seguida, assinale a alternativa que apresenta a sequência 
correta. 

 
(   ) O uso de blocos de forma eficiente e correta 

demanda uma rígida padronização das layers e das 
cores de seus elementos. O usuário, ao criar um 
bloco e, principalmente, ao utilizar um bloco feito por 
terceiros, deve verificar se as cores e as layers se 
adaptam à sua metodologia e padrão de desenho. 

(   ) Os blocos em desenho CAD são estruturas 
compostas. Nessas estruturas, é possível agrupar 
entidades de diversos tipos (linhas, arcos, textos 
etc.) e atribuir-lhes um nome de identificação e um 
ponto de inserção. 

(   ) O comando Make Block salva desenhos como 
blocos que podem ser inseridos em qualquer 
trabalho. Estes blocos são salvos como arquivos 
desenho. Uma vez que estes desenhos podem ser 
inseridos em qualquer trabalho realizado, este 
comando se torna muito útil para a criação de uma 
biblioteca de símbolos.  

(   ) Os atributos são informações sobre o bloco que 
podem ser inseridas e modificadas sempre que um 
bloco for inserido. Os atributos devem ser definidos 
antes que um bloco seja salvo. A possibilidade de 
inserção de atributos se mostra muito útil para a 
geração de uma lista de materiais, por exemplo. 

 
(A) V/ V/ V/ V 

(B) V/ V/ F/ V 

(C) V/ V/ V/ F 

(D) F/ F/ F/ V 

(E) F/ V/ V/ F 

29. Dentre os diversos aplicativos e softwares que facilitam o 
trabalho de arquitetos, assinale a alternativa que 
apresenta o aplicativo móvel e para web que permite 
visualizar, criar, editar e compartilhar desenhos e, ainda, 
aceita correção de desenhos no local da obra e 
compartilhamento de desenhos tipo DWG.  

 
(A) MagicPlan – Sensopia. 

(B) IDesign – TouchAware.  

(C) AutoCAD 360 – Autodesk Inc.  

(D) 3D Spacer.  

(E) Home Designer Suite.  
 

 
30. Considerando os recursos e as funções do teclado no 

programa AutoCAD, assinale a alternativa que apresenta 
a função da tecla F5 – ISOPLANE RIGHT/LEFT/TOP. 

 
(A) Liga e desliga o método de criação polar, mostrando 

posições verticais e horizontais na área de trabalho.  

(B) Liga e desliga o Otrack que ajuda a desenhar 
objetos em ângulos específicos ou em relações com 
outras entidades.  

(C) Liga e desliga o método de criação de entidades 
ortogonais (vertical e horizontal).  

(D) Muda o tipo de perspectiva para desenhos 
isométricos. 

(E) Liga e desliga o contador de coordenadas.  
 

 
31. Considerando a concepção de um projeto arquitetônico e 

suas instalações, assinale a alternativa que adota 
corretamente as diretrizes gerais indicadas para a 
elaboração de projetos de instalações de prevenção e 
combate a incêndio. 

 
(A) Se na edificação houver áreas isoladas sujeitas a 

risco de incêndio, deverá ser previsto sistema de 
proteção por extintores manuais e a proteção a 
edificações por extintores-carreta.  

(B) A quantidade de unidades extintoras deverá ser 
determinada obedecendo a normas, que, em 
princípio, dependem da distância máxima para o 
alcance do sistema, apenas. 

(C) Todas as edificações deverão conter sistema de 
proteção por hidrantes.  

(D) Admite-se somente reservatório exclusivo para o 
sistema como fonte de alimentação de água (com 
instalação hidropneumática), destinado 
exclusivamente ao serviço de proteção contra 
incêndio. 

(E) A válvula de retenção e alarme mantém a rede de 
jusante pressurizada e possibilita testes, drenagem e 
alarmes periódicos. É formada por um dispositivo 
destinado a proteger, com chuveiros automáticos, 
uma área delimitada da edificação.  
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32. Considerando o programa AutoCAD, assinale a alternativa 
que apresenta os comandos que permitem, 
respectivamente, prolongar um objeto para que este se 
encontre com outro objeto e criar cópias paralelas de 
linhas, polilinhas e splines. 

 

(A) EXTEND e OFFSET. 

(B) POLYLINE e ARC.  

(C) CHAMFER e FILLET. 

(D) TRIM e SCALE.  

(E) ARRAY e MIRROR.  
 

 

33. Assinale a alternativa que apresenta a ligação para a terra 
de um ponto determinado de circuito elétrico, como de 
transformadores, motores, para-raios e outros, que tem, 
por finalidade, permitir o desempenho normal e seguro do 
circuito elétrico.  

 

(A) Elemento de captação.  

(B) Condutor de descida.  

(C) Condutor equipotencial.  

(D) Terra de funcionamento. 

(E) Terminal de terra.  
 

 

34. Assinale a alternativa que apresenta a função da 
ferramenta Polar Tracking, no programa AutoCAD. 

 

(A) Cria uma grade de pontos dentro do Drawing Limits 
ajustado. Acerta espaçamento nas guias X e Y 
Spacing.  

(B) Tabula o cursor de tela na dimensão selecionada 
para qualquer dimensão escolhida. É utilizada para 
se trabalhar em um plano isométrico.  

(C) É um sistema de ajuste “magnético” para se 
desenhar em certa angulação mais rapidamente. 
Normalmente, vem ajustado para ângulos em 90°. 
Pode ser muito bem visualizado quando se é 
desenhada uma linha na área de trabalho.  

(D) É um sistema “magnético” para pontos de precisão 
em entidades. Com este item ligado, podem-se obter 
os comandos de precisão de uma entidade sem 
precisar entrar no Menu Osnap . 

(E) Regenera o desenho e renova a tela atual. Também 
reindexa o banco de dados do desenho para 
aperfeiçoar a apresentação e o desempenho da 
seleção de objetos. 

 
 

35. Considerando os comandos de visualização no programa 
AutoCAD, assinale a alternativa que apresenta a 
ferramenta de navegação Aerial View. 

 
(A) Amplia uma região especificada por uma janela. 

(B) Mostra tudo que está desenhado dentro ou fora dos 
limites. 

(C) Move a apresentação do desenho em 0,1 unidade 
para a direita, esquerda, cima ou baixo, 
respectivamente.  

(D) Aumenta ao máximo e centraliza a visualização do 
desenho na tela gráfica. 

(E) Apresenta uma vista do desenho em uma janela 
separada para que se possa localizar uma área 
específica. Com a janela Aerial View aberta, pode-se 
aplicar zoom e deslocar a tela, sem selecionar uma 
opção de menu ou digitar um comando. 

36. Trata-se do comando que possibilita a inclusão de objetos 
para paisagismo em cenas que serão renderizadas. Com 
isso, esses objetos não precisam ser criados no AutoCAD. 
Este comando permite que o referido objeto venha a ser 
modificado (altura e posição). Diante do exposto, assinale 
a alternativa que apresenta o comando descrito. 

 
(A) O comando View > Render > Render.  

(B) O comando View > Render > Landscape New.  

(C) O comando View > Render > Scene.  

(D) O comando View > Render > Materials.  

(E) O comando View > Render > Mapping.  
 

 
37. Com relação ao conhecimento de AutoCAD, assinale a 

alternativa que preenche corretamente a lacuna. 
 

O comando ____________ cria objetos sólidos 

tridimensionais a partir de perfis bidimensionais, conferindo-lhes 

profundidade. Também pode criar objetos definidos pelo volume 

gerado por um perfil ao percorrer um caminho definido por uma 

entidade como linha, arco etc.. 

 
(A) Revolve 

(B) Slice 

(C) Extrude 

(D) Interference  

(E) 3D Poly.  
 

 
38. Considerando a montagem de uma planta baixa no 

programa AutoCAD, assinale a alternativa que apresenta 
o comando que se deve usar quando é preciso apagar 
partes de linhas, traços, círculos arcos e polylines ou 
dividi-los em duas entidades distintas. 

 
(A) Modify > Break.  

(B) Draw > Mline.  

(C) Draw > Point > Divide.  

(D) Draw > Point > Measure.  

(E) Modify > Extend > Edge.  
 

 
39. Considerando as extensões de arquivos criados e 

utilizados pelo AutoCAD, assinale a alternativa que 
apresenta os formatos de arquivo padrão do software e 
formatos de arquivo que armazena modelos de layout, 
respectivamente. 

 
(A) Formato *.dwg e formato *.dwt  

(B) Formato *.dxf e formato*.dws  

(C) Formato acad.pgp e formato *.pat  

(D) Formato *.dwf e formato*.dxe  

(E) Formato *.fas e formato*.vlx  
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40. Considerando a cotagem dos desenhos no programa 
AutoCAD, assinale a alternativa que apresenta o comando 
que se deve usar quando se quer criar cotas verticais e 
horizontais, em quatro direções em relação aos pontos de 
origem. 

 
 

(A) Dimension < Leader.  

(B) Dimension < Continue.  

(C) Dimension < Baseline.  

(D) Dimension < Linear.  

(E) Dimension < Quick Dimension.  
 

 
41. Conceituar a implantação geral em termos de massas 

edificadas do produto arquitetônico pretendido, de forma a 
verificar sua viabilidade física e legal, além de conceituar o 
posicionamento das edificações em função dos 
parâmetros legais (recuos, taxas de ocupação etc.) e 
definir a volumetria das edificações trata-se da seguinte 
etapa do processo projetual arquitetônico: 

 
(A) Estudo Preliminar.  

(B) Anteprojeto. 

(C) Concepção e Análise de Viabilidade.  

(D) Qualificação e quantificação do potencial construtivo 
do empreendimento.  

(E) Verificação Analítica da Viabilidade Econômica do 
Empreendimento.  

 
 

42. Considerando a composição de um quadro de áreas de 
um projeto arquitetônico, assinale a alternativa que 
apresenta a taxa de ocupação da edificação em estudo. 

 
(A) É um número que, multiplicado pela área do lote, 

indica a quantidade máxima de metros quadrados 
que podem ser construídos em um lote, somando-se 
às áreas de todos os pavimentos.  

(B) É o percentual utilizado pela edificação em relação à 
área total do lote, considerando apenas sua projeção 
horizontal, desconsiderando, assim, a altura da 
edificação e o número de pavimentos.  

(C) É um percentual expresso pela relação entre a área 
do lote sem pavimentação impermeável e sem 
construção no subsolo e a área total do terreno.  

(D) É a soma das diversas áreas que não entram no 
cálculo da área máxima de construção permitida em 
determinado terreno (área computável), mas que, 
ainda assim, deve ser considerada na área total.  

(E) É a soma das áreas cobertas de todos os 
pavimentos da edificação.  

 
 

43. Considerando a reabilitação de edifícios, assinale a 
alternativa que conceitua um Retrofit. 

 
(A) Intervenção que consiste na restituição do imóvel à 

sua condição original, sem que haja acréscimo na 
sua área construída. 

(B) Intervenção que consiste na troca ou substituição de 
componentes ou subsistemas específicos de um 
edifício que se tornaram inadequados ou obsoletos, 
seja pelo passar do tempo ou em função da 
evolução tecnológica ou de novas necessidades dos 
usuários. A intenção é conciliar renovação e 
manutenção, pois, ao mesmo tempo em que se 
devem manter características originais da edificação, 
é preciso modernizá-la. 

(C) Intervenção que consiste nas obras de construção 
posteriores a uma demolição total ou parcial de uma 
edificação das quais resulte a manutenção ou a 
reconstituição da estrutura das fachadas e do 
número de pisos. 

(D) Intervenções mecânicas e químicas, estruturais e/ou 
estéticas com a finalidade de revitalizar um bem 
cultural, resgatando seus valores históricos e 
artísticos, respeitando-se, ao máximo, a integridade 
e as características históricas, estéticas e formais do 
bem cultural. 

(E) Intervenção que consiste na reabilitação de edifícios 
de forma preventiva, que visa a conservar ou 
recuperar a sua capacidade funcional, bem como 
atender às necessidades de segurança dos 
usuários. 

 
 

44. Considerando a influência da parametrização dos 
softwares CADD arquiteturais no desenvolvimento de um 
projeto arquitetônico, marque V para verdadeiro ou F para 
falso e, em seguida, assinale a alternativa que apresenta a 
sequência correta. 

 
(...) O uso do software paramétrico AutoCAD baseia-se 

no modelo central do edifício, enquanto no software 
não paramétrico Revit, baseia-se nas vistas 
ortogonais segmentadas do edifício.  

(...) No software não paramétrico, limita-se às 
informações gráficas da geometria do edifício, 
enquanto no software paramétrico são associadas 
adicionalmente informações não gráficas da 
execução do edifício. 

(...) No que se refere à execução de alterações no 
projeto arquitetônico, no software paramétrico, as 
alterações são mais trabalhosas e mais suscetíveis 
a erros, visto que engloba muito mais informações 
projetuais em relação ao software não paramétrico. 

(...) A utilização de software paramétrico exige maiores 
conhecimentos técnicos dos projetistas sobre a 
execução da obra e utiliza um sistema de 
representação projetual (modelo 3D) mais 
compreensível aos agentes da indústria da 
construção. 

 
(A) V/ V/ V/ V 

(B) F/ V/ F/ V 

(C) V/ V/ V/ F 

(D) F/ F/ F/ V 

(E) F/ V/ V/ F 
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45. Assinale a alternativa que apresenta o tipo de via 
classificada, segundo o Código de Trânsito Brasileiro 
(CTB), a partir de suas características funcionais e físicas 
por acessos especiais com trânsito livre, sem intersecções 
em nível, sem acessibilidade direta aos lotes lindeiros e 
sem travessia de pedestres em nível (velocidade máxima 
= 80km/h). 

 
(A) Vias secundárias de distribuição.  

(B) Vias arteriais.  

(C) Vias expressas. 

(D) Vias coletoras.  

(E) Vias locais.  
 

 
46. Considerando os principais programas de modelação 

paramétrica direcionados para o modelo arquitetônico, 
assinale a alternativa que apresenta as características do 
Archicad. 

 
(A) É um software proprietário de modelagem 

tridimensional baseado na tecnologia NURBS. 
Desenvolvido para o sistema operacional Windows, 
o programa nasceu como um plug-in para o 
AutoCAD, da Autodesk. Posteriormente, tornou-se 
um aplicativo independente. É usualmente utilizado 
em diversos ramos de design, em arquitetura e 
também engenharia mecânica. Os arquivos gerados 
possuem a extensão .3dm.  

(B) É um software proprietário de modelagem 
tridimensional que pode ser utilizado em qualquer 
área que seja necessária a geração de modelos 
tridimensionais, geração de imagens renderizadas, 
animação e jogos, com aplicações em arquitetura, 
conseguindo ler e escrever muitos formatos de 
arquivos, sendo eles renderizáveis ou modelos 
tridimensionais. 

(C) É um software proprietário para a criação de 
modelos em 3D no computador. Trata-se de um 
produto do grupo Google muito utilizado na área de 
Arquitetura devido à sua facilidade de modelagem 
de estudos de formas e volumes tridimensionais. 
Uma vez desenhado o modelo, é possível exportá-lo 
por meio da versão PRO para outros formatos (2D e 
3D), como DWG, DXF, 3DS, OBJ, XSI ou VRML 
para dar continuidade ao projeto do desenho 
preliminar.  

(D) É considerado um programa 5D, porque, além da 
modelação 3D, permite igualmente a alimentação de 
dados à obra em tempo real, bem como a 
quantificação de todo o processo e respectiva 
orçamentação. Permite, também, a conversão do 
modelo em diversos formatos, um dos quais é de 
domínio público e freeware: o formato IFC, que 
exporta todo o modelo e respectivos dados apensos, 
em formato txt.  

(E) É um programa de modelagem tridimensional que 
permite renderização de imagens e animações, 
sendo usado em produção de filmes de animação, 
jogos em 3D, vinhetas e comerciais para TV, 
maquetes eletrônicas e na criação de qualquer 
mundo virtual. Os arquivos gerados pelo software 
possuem a extensão nativa .MAX.  

 
 

47. Assinale a alternativa que apresenta as características do 
sistema de impermeabilização laminar. 

 
(A) Este tipo de impermeabilização é de fácil execução e 

apresenta uma grande economia, porém está 
suscetível a trincas como as estruturas com as quais 
estão solidárias. Deve ser empregada em locais não 
sujeitos à forte exposição solar, à expressiva 
variação térmica, à vibração ou ao trabalho eventual.  

(B) Encontram-se, neste sistema, os concretos 
impermeáveis em que a adição de 
impermeabilizante ao concreto reforça sua 
impermeabilidade. É mais frequentemente 
empregado em obras enterradas, como galerias, 
subsolos, muros de arrimo, cisternas etc.. 

(C) Este tipo de impermeabilização é feito com manta 
pré-fabricada ou com elastômeros dissolvidos e 
aplicados no local em forma de pintura ou melação, 
em várias camadas que, ao evaporar o solvente, 
deixam uma membrana hipoteticamente elástica 
sobre a superfície.  

(D) Este sistema é usado em elementos sujeitos a 
variações térmicas, vibrações, forte exposição ao 
sol, sobrecargas e eventuais movimentações, sendo 
indicado em lajes, terraços, calhas etc.. Os materiais 
que compõem este sistema são os betuminosos, as 
resinas, os elastômeros e os polímeros sintéticos.  

(E) Este sistema é conhecido como pintura armada ou 
melação armada. É executado com elastômeros ou 
asfaltos, armados ou estruturados pela intercalação 
de materiais rígidos, como feltros asfálticos, tecidos 
de nylon, lã de vidro, tecidos de juta e lâminas de 
alumínio. Este tipo de impermeabilização é capaz de 
absorver pequenos movimentos da base sem sofrer 
danos ou perder sua eficiência.  

 
 

48. Conforme a NBR 9050/2004, que padroniza acessibilidade 
a edificações, mobiliário, espaços e equipamentos 
urbanos, assinale a alternativa correta. 

 
(A) A largura mínima necessária para a transposição de 

obstáculos isolados com extensão de, no máximo, 
0,40m deve ser de 1,20m.  

(B) A largura mínima para a transposição de obstáculos 
isolados com extensão acima de 0,40m deve ser de 
0,80m. 

(C) Em rotas acessíveis, os desníveis entre 5mm até 
15mm devem ser considerados como degraus e 
devem ter sinalização tátil de alerta.  

(D) Os pisos devem ter superfície regular, firme, estável 
e antiderrapante sob qualquer condição, que não 
provoque trepidação em dispositivos com rodas. 
Admite-se inclinação transversal da superfície até 
3% para pisos internos e 5% para pisos externos e 
inclinação longitudinal máxima de 10%. Inclinações 
superiores a 10% são consideradas rampas.  

(E) A largura das rampas (L) deve ser estabelecida de 
acordo com o fluxo de pessoas. A largura livre 
mínima recomendável para as rampas em rotas 
acessíveis é de 1,50m, sendo o mínimo admissível 
1,20m.  
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49. Sobre os procedimentos de impermeabilização em 
situações frequentes nas edificações, assinale a 
alternativa incorreta. 

 
(A) As lajes expostas são estruturas que estão 

submetidas a grandes variações térmicas, portanto o 
sistema mais adequado e que oferece o 
desempenho necessário é o de mantas asfálticas 
termoplásticas não aderidas, pois permite que os 
elementos trabalhem independentemente, sem 
afetar as mantas do sistema de impermeabilização.  

(B) Nos reservatórios de água (caixa d’água e piscinas), 
o sistema flexível, executado com mantas asfálticas 
termoplásticas de 4mm de espessura, é o mais 
indicado.  

(C) Em coberturas transitáveis por pedestres, a 
impermeabilização rígida não é recomendada, pois 
estas lajes são suscetíveis de fissuras provenientes 
de oscilação térmica. Recomendam-se mantas 
asfálticas ou elastoméricas.  

(D) Nas áreas frias cobertas (pisos de banheiros, 
cozinhas, áreas de serviço), deve-se prever uma 
impermeabilização delgada feita por processo de 
pintura ou a aplicação de manta com espessura de 
1,5mm aderida à base com um produto à base de 
cola. Desse modo, impedem-se as infiltrações 
eventuais que ocorreriam durante o curto período 
entre o início da lavagem e o escoamento total da 
água. 

(E) Por estarem sujeitas a grandes movimentações e 
solicitações, as juntas de dilatação estrutural são 
pontos críticos que merecem especial cuidado em 
sua impermeabilização. O sistema mais indicado é 
uma pintura de impermeabilizante com tinta 
impermeável de longa duração, que deve ter um 
peso mínimo, por m2, de 350 gramas, para se obter 
adequada espessura e ser impermeável às águas 
projetadas, permitindo que a junta dilate. 

 
 

50. Considerando a NBR 9050/2004, assinale a alternativa 
que apresenta o número de vagas que devem ser 
reservadas para estacionamento de veículos que 
conduzam, ou seja, conduzidos por pessoas com 
deficiência, em um estacionamento de uso público onde 
será implantado um número total de 1.200 vagas de 
veículos. 

 
(A) 120 vagas 

(B) 12 vagas. 

(C) 60 vagas. 

(D) 30 vagas. 

(E) 40 vagas. 
 
 
 
 
 
 
 
 
 
 
 

51. Assinale a alternativa que descreve o sistema de fachada 
ventilada. 

 
(A) O sistema proporciona um afastamento entre a 

parede da edificação e o revestimento e cria uma 
câmara de ar em movimento, que permite a 
ventilação natural por meio do efeito chaminé, em 
que o ar entra frio pela parte inferior e sai quente 
pela parte superior. Desta forma, o produto confere 
maior conforto térmico, pois evita umidade e 
condensações. O revestimento oferece mais 
proteção contra chuvas direcionadas e torrenciais, 
por ser impermeável. 

(B) Neste sistema, as colunas verticais da fachada – 
cujas funções são suportar a pressão do vento e 
receber as vedações – são instaladas nos frontais 
de laje da edificação, com ancoragens próprias. 
Paralelamente, na instalação, sobem as divisões 
horizontais (travessas). Por fim, novamente pelo 
lado externo, instaladores em balancins parafusam 
os quadros de vidro. Esse sistema foi largamente 
usado nas primeiras fachadas e, ainda hoje, é muito 
empregado com versões melhoradas e de alto 
desempenho. Suas vantagens são o baixo custo de 
transporte e manuseio, além de oferecer flexibilidade 
para ajustes em obra.  

(C) É um tipo de fachada-cortina em que o vidro é 
colado com silicone nos perfis dos quadros de 
alumínio, ficando a estrutura oculta, na face interna. 
Este sistema eliminou o alumínio externo, 
possibilitando a construção de uma fachada 
totalmente envidraçada. Toda infraestrutura fica 
oculta pelos vidros, desta forma, permite grande 
flexibilidade e é largamente usado.  

(D) Este sistema é considerado um desenvolvimento da 
fachada-cortina tipo stick. O sistema é composto por 
painéis modulares estruturados com perfis de 
alumínio e fechados com vidro. Além dessa estrutura 
básica, os módulos podem ainda receber elementos 
para sombreamento ou para diversificar o 
acabamento, como granito, alumínio composto 
(ACM), brises, entre outros.  

(E) Neste sistema, os painéis incluem a estrutura em 
alumínio, os vidros e todos os complementos. Os 
módulos permitem a montagem de fachadas planas 
ou poligonais, verticais ou inclinadas, lisas ou com 
recortes em alto ou baixo relevo. As ancoragens 
podem ser reguladas em três direções (x, y, z). Os 
módulos são aptos a receber vidro, granito e outros 
produtos usados no revestimento de edifícios.  
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52. A Norma Brasileira ABNT NBR 9050/2004 estabelece 
critérios e parâmetros técnicos a serem observados 
quando do projeto, da construção, instalação e adaptação 
de edificações, mobiliário, espaços e equipamentos 
urbanos às condições de acessibilidade. Para os efeitos 
desta Norma, é correto afirmar que uma área de 
transferência corresponde ao(à) 

 
(A) elemento edificado ou instalado destinado a 

constituir barreira no piso para proteção de árvores, 
áreas ajardinadas, espelhos d’água e espaços 
similares. 

(B) espaço sem obstáculos para que a pessoa que 
utiliza cadeira de rodas possa manobrar, deslocar-
se, aproximar-se e utilizar o mobiliário ou o elemento 
com autonomia e segurança.  

(C) espaço necessário para que uma pessoa utilizando 
cadeira de rodas possa se posicionar próximo ao 
mobiliário para o qual necessita transferir-se.  

(D) área com acesso direto para uma saída destinada a 
manter em segurança pessoas portadoras de 
deficiência ou com mobilidade reduzida, enquanto 
aguardam socorro em situação de sinistro.  

(E) elemento edificado ou instalado junto aos limites 
laterais das superfícies de piso destinado a definir 
claramente os limites da área de circulação de 
pedestres, perceptível por pessoas com deficiência 
visual. 

 
 

53. Com relação à ventilação e a aberturas no interior das 
edificações, marque V para verdadeiro ou F para falso e, 
em seguida, assinale a alternativa que apresenta a 
sequência correta. 

 
(...) O dimensionamento de elementos de proteção solar, 

localizados na porção superior da abertura, 
influencia a direção do fluxo de entrada de ar. 

(...) Janelas pivotantes direcionadas para baixo 
apresentam uma circulação de ar satisfatória. 

(...) Protetores solares em forma de venezianas 
proporcionam uma circulação de ar difusa e 
satisfatória. 

(...) Janelas de abrir de eixo vertical apresentam área útil 
de ventilação de 50% da área da janela. Permitem o 
direcionamento do fluxo de ar e controle da área de 
entrada e saída de ar.  

 
(A) V/ V/ V/ V 

(B) V/ V/ F/ F 

(C) V/ V/ V/ F 

(D) F/ F/ F/ V  

(E) F/ V/ V/ F 
 
 
 
 
 
 
 
 
 

54. Assinale a alternativa que apresenta as principais 
características de um Edifício Ecológico (Green Building). 

 
(A) Foco nos objetivos da edificação, que incluem a 

satisfação do usuário e a responsabilidade ambiental 
da edificação em relação ao meio ambiente. Análise 
e tratamento dos processos produtivos em todo o 
ciclo de vida da edificação, desde a extração de 
matéria-prima para fabricação de materiais e 
componentes de construção, até a destinação do 
entulho de obra e outros produtos resultantes da 
demolição da edificação. Opção por materiais, 
componentes e sistemas alternativos que 
contribuam para o uso racional dos recursos naturais 
no âmbito da edificação, tais como exploração da 
energia solar, reaproveitamento da água da chuva, 
reciclagem e reutilização.  

(B) Foco na eficiência energética da edificação e na 
produtividade das atividades do usuário; uso 
intensivo de tecnologia de ponta sob a forma de 
componentes, equipamentos e sistemas destinados 
à automação predial; disponibilidade de vários 
serviços e facilidades (telecomunicações, 
transmissão de dados e rede de dados).  

(C) Foco em materiais e tecnologias construtivas que 
maximizam aproveitamento dos espaços. Opção por 
componentes e sistemas que viabilizam o uso 
racional de recursos como ar, água, energia e outros 
combustíveis. Opção de construção de edifícios 
altos preparados para suportar grandes impactos e 
movimentações.  

(D) Foco no desempenho da edificação ao longo da vida 
útil e na satisfação do usuário; valorização dos 
aspectos estéticos e institucionais do 
empreendimento; ações para integração da 
edificação com a cidade e com a sociedade por meio 
de parcerias entre a sociedade civil organizada, a 
indústria e o governo; uso da tecnologia de ponta 
somente em casos em que a tecnologia não 
viabilize, por si só, o desempenho adequado da 
edificação.  

(E) Foco na sustentabilidade, não só da edificação, mas 
também da indústria da construção; ampliação das 
preocupações com o meio ambiente; ações voltadas 
para o desenvolvimento sustentável das cidades e 
da indústria, tais como uso preferencial de 
tecnologias e recursos disponíveis na região onde a 
edificação será construída, contribuindo para o 
desenvolvimento socioeconômico do local; 
envolvimento da sociedade na definição de 
instrumentos legais para a regulamentação da 
produção das edificações e suas partes, ou seja, 
projeto, fabricação de materiais e componentes, 
construção, operação/ uso, manutenção, demolição, 
entre outras atividades.  
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55. Segundo a ABNT NBR 9050/2004, assinale a alternativa 
que apresenta a indicação de uso para piso tátil de alerta. 

 
(A) Deve ser utilizado no sentido de deslocamento em 

cor e textura contrastante com o restante do piso, 
em áreas de circulação, para indicar o caminho a ser 
percorrido.  

(B) Deve ser utilizado para indicar: rebaixamento de 
calçadas; obstáculos em balanço sobre o passeio; 
porta de elevadores; desníveis, como vãos, 
plataformas de embarque/ desembarque e palcos; 
no início e término de escadas e rampas. 

(C) Deve ser utilizado em espaços amplos, como 
calçadão, por exemplo, para que a pessoa não se 
perca, ou onde a guia de balizamento não seja 
contínua, tais como galerias recuadas com pilares 
na frente, arame farpado no limite do lote, lixeiras 
sobre o passeio, recuos sem muro e estacionamento 
de veículos no recuo.  

(D) Piso caracterizado pela utilização de cor 
contrastante em relação às áreas adjacentes e 
destinado a constituir guia de balizamento ou 
complemento de informação, perceptível por 
pessoas com deficiência visual.  

(E) Deve ser utilizado quando houver mudança de 
direção, formando ângulo superior a 90°; a linha-guia 
deve ser sinalizada com piso tátil de alerta.  

 
 

56. Assinale a alternativa que apresenta a atividade técnica 
que, durante e após a conclusão de obra ou serviço 
técnico, consiste na revisão dos elementos do projeto em 
conformidade com o que foi executado, objetivando tanto 
sua regularidade junto aos órgãos públicos como sua 
atualização e manutenção. 

 
(A) Coordenação e compatibilização de projetos.  

(B) Coordenação de equipe multidisciplinar.  

(C) Assessoria para aprovação de projeto.  

(D) Assistência à execução da obra.  

(E) As built.  
 

 
57. Com relação à competência para o licenciamento 

ambiental, segundo as Resoluções CONAMA nº 01/86 e 
237/97 para as diversas possibilidades de construção de 
estradas, marque V para verdadeiro ou F para falso e, em 
seguida, assinale a alternativa que apresenta a sequência 
correta. 

 
(   ) A estrada-01 possui um trecho que atravessa área 

indígena. Neste caso, o licenciamento será a cargo 
do IBAMA. 

(   ) A estrada-02 atravessa mais de um Estado. Neste 
caso, o licenciamento será pelo IBAMA. 

(   ) A estrada-03 está adstrita aos domínios de um único 
Município. O licenciamento será pelo órgão 
municipal. 

(   ) A estrada-04 está adstrita aos domínios de apenas 
um Município, mas atravessa uma unidade de 
conservação federal. O licenciamento será feito pelo 
órgão estadual.  

 

(A) V/ V/ V/ V 

(B) V/ V/ F/ F 

(C) V/ V/ V/ F 

(D) F/ F/ F/ V 

(E) F/ V/ V/ F 
 

 
58. Assinale a alternativa que conceitua um Plano de Controle 

Ambiental (PCA).  
 

(A) Documento técnico mediante o qual, com 
fundamento nos objetivos gerais de uma área sujeita 
a regime especial de proteção, se estabelecem o 
seu zoneamento e as normas que devem presidir o 
uso da área e o manejo dos recursos naturais, 
inclusive a implantação das estruturas físicas 
necessárias à sua gestão. 

(B) Documento que norteia os programas e as ações 
mitigadoras de projetos executivos para minimização 
de impactos ambientais avaliados pelo EIA/RIMA e 
entregues para a obtenção da Licença Prévia, de 
acordo com a legislação.  

(C) Plano que reúne informações, diagnósticos, 
levantamentos e estudos que permitam a avaliação 
da degradação ou alteração, e a consequente 
definição de medidas adequadas à recuperação de 
uma área, em conformidade com a legislação 
pertinente. 

(D) Instrumento técnico que constitui a base para a 
política de desenvolvimento e de ordenamento do 
uso do solo e ocupação urbana, dos normativos 
urbanísticos e edilícios, da mobilidade e do 
transporte ou da drenagem pluvial, em áreas de 
município ou em regiões metropolitanas, nos termos 
da legislação vigente. 

(E) Instrumento técnico voltado para o desenvolvimento 
local, que é expresso em metas e objetivos de curto 
e médio prazo, e se submete a constantes revisões, 
apresentando-se na forma de planos diversos, como 
planos de mobilidade, de habitação e de 
saneamento ambiental.  

 
 

59. Com relação à morfologia urbana e aos tipos de planos 
urbanos, assinale a alternativa que apresenta 
características de uma planta ortogonal. 

 
(A) Apresenta um traçado anárquico, com ruas estreitas 

e formas tortuosas, muitas delas a terminar em 
becos e pátios interiores sem saída.  

(B) Esta planta tem a vantagem de facilitar o acesso de 
qualquer ponto da cidade e adapta-se muito bem 
aos sítios com relevo mais acidentado.  

(C) As cidades com este tipo de planta apresentam um 
núcleo central em volta do qual se desenvolvem 
artérias sensivelmente circulares.  

(D) Caracteriza-se pelo traçado geométrico regular com 
ruas direitas e perpendiculares entre si. Adapta-se 
muito bem a áreas planas.  

(E) Apresenta um traçado como se fosse um tabuleiro 
de xadrez, como uma praça principal no centro da 
cidade, e as ruas formam quadrados.  
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60. Considerando o conceito de “arquitetura vernacular”, 
marque V para verdadeiro ou F para falso e, em seguida, 
assinale a alternativa que apresenta a sequência correta. 

 

(...) Envolve atividades técnicas relacionadas à 
concepção e à execução de projetos para espaços 
externos, livres e abertos, privados ou públicos, 
como parques e praças, considerados isoladamente 
ou em sistemas, dentro de várias escalas, inclusive 
a territorial.  

(...) Corresponde à forma de arquitetura em que são 
empregados recursos, técnicas e materiais 
regionais, do próprio ambiente onde a edificação é 
construída, apresentando, assim, um caráter 
regional ou local em decorrência desses fatores. Ao 
mesmo tempo, também são denominadas formas de 
arquitetura vernacular aquelas em que os 
conhecimentos de edificações ou utilização de 
materiais são transmitidos de geração para geração. 

(...) Corresponde à linguagem arquitetônica mais antiga 
e uma das mais sustentáveis e adequadas ao 
ambiente onde está inserida. São exemplo de 
arquitetura vernacular as casas de pau-a-pique, de 
adobe, de bambu, de madeira, de pedras, com 
telhado de palha etc.. 

(...) Consiste na intervenção em ambientes internos ou 
externos de edificação, definindo a forma de uso do 
espaço em função de acabamentos, mobiliário e 
equipamentos, além das interfaces com o espaço 
construído, para adequação às novas necessidades 
de utilização. Esta intervenção se dá no âmbito 
espacial; estrutural; das instalações; do 
condicionamento térmico, acústico e lumínico; da 
comunicação visual; dos materiais, texturas e cores; 
e do mobiliário.  

 

(A) V/ V/ V/ V 

(B) V/ V/ F/ F 

(C) V/ V/ V/ F 

(D) F/ F/ F/ V 

(E) F/ V/ V/ F 
 

 

61. Assinale a alternativa que apresenta o caderno de 
encargos de uma obra. 

 

(A) Documento em que se registram as operações de 
cálculo de custo da construção, somando todas as 
despesas correspondentes à execução de todos os 
serviços previstos nas especificações técnicas. 

(B) Documento em que se registram, pela ordem de 
sucessão em que serão executados, os serviços 
necessários à realização da construção e os 
respectivos prazos, previstos em função dos 
recursos e das tecnologias que se supõem que 
serão disponíveis. 

(C) Documento que define o relacionamento entre as 
partes, estabelecendo, de forma objetiva, seus 
direitos e obrigações, nas diversas fases da 
construção. 

(D) Documento que relaciona precisa, completa e 
ordenadamente os materiais de construção, suas 
características e métodos de ensaio. Paralelamente, 
descreve como, quando e onde empregá-los. 

(E) Documento que se constitui na averiguação das 
potencialidades de um terreno, atendendo às 
exigências da legislação municipal e às 
necessidades do programa a ser implantado. 

62. Com relação à Lei Federal nº 6.766/1979, também 
conhecida como Lei Lehmann, e suas alterações, marque 
V para verdadeiro ou F falso e, em seguida, assinale a 
alternativa que apresenta a sequência correta. 

 
(...) A Lei Federal nº 6.766/1979 foi alterada pela Lei 

Federal nº 11.445/2007, sendo modificada a 
redação. Onde antes constava como infraestrutura 
básica a rede de esgoto sanitário, passou a constar 
solução para o adequado esgotamento sanitário. 
Essa alteração é justificada por não ser necessária a 
implantação de redes coletoras de esgotamento 
sanitário em todos os parcelamentos. Dependendo 
da densidade habitacional, da sua localização em 
relação à rede existente e condições geológicas e 
topográficas, as soluções individuais, compostas por 
fossas sépticas, podem garantir a correta destinação 
final do esgotamento sanitário.  

(...) Para fins de urbanização, o parcelamento do solo 
não é permitido em terrenos alagadiços, terrenos 
aterrados com material nocivo à saúde pública, em 
declividades iguais ou superiores a 30% e em locais 
em que a poluição impeça condições sanitárias 
suportáveis. Importante esclarecer que essa 
proibição não é definitiva, ela perdura apenas 
enquanto não forem realizadas as medidas de 
adequação técnica da salubridade e segurança para 
adaptar essas áreas ao assentamento humano. 

(...) Cabe ao loteador destinar parte da gleba para a 
implantação do sistema de circulação, de 
equipamento urbano e comunitário, bem como 
espaços livres de uso público. A localização das 
áreas destinadas aos equipamentos urbanos e 
comunitários e áreas livres de uso público pode ser 
indicada pelo Município durante o processo de 
aprovação do projeto de loteamento. Essas áreas 
devem passar para o domínio do Município no 
momento do registro do loteamento junto ao Cartório 
de Registro de Imóveis. 

(...) Para a implantação do parcelamento, o loteador 
deve observar a obrigatoriedade de articular as vias 
do novo loteamento às vias adjacentes oficiais, 
harmonizando-se com a topografia local. Além disso, 
devem ser reservadas áreas não edificáveis de 15 
metros de cada lado, ao longo das águas correntes 
e dormentes e das faixas de domínio público das 
rodovias e ferrovias. 

 
(A) V/ V/ V/ V 

(B) V/ V/ F/ F 

(C) V/ V/ V/ F 

(D) F/ F/ F/ V 

(E) F/ V/ V/ F 
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63. Com relação ao sistema construtivo Light Steel Framing, 
assinale a alternativa correta. 

 

(A) Sistema construtivo estruturado em perfis de aço 
galvanizado formado a frio, projetados para suportar 
as cargas da edificação e trabalhar em conjunto com 
outros subsistemas industrializados, de forma a 
garantir os requisitos de funcionamento da 
edificação. 

(B) Sistema construtivo de vedação, não estrutural, que 
utiliza aço galvanizado em sua sustentação, com 
espessura nominal de 0,50mm, com necessidade de 
revestimento de Zinco (média mundial de 120g/m²) e 
que necessita de uma estrutura externa ao sistema 
para suportar as cargas da edificação.  

(C) Sistema construtivo composto por um compósito de 
cimento reforçado com fibras de vidro que atuam 
como microarmadura da matriz de cimento. O 
sistema pode ser utilizado em painéis de fachada, 
canais, reservatórios, pavimentos industriais, 
barreiras acústicas, chapas onduladas para 
coberturas, grelhas decorativas, aduelas para túneis 
etc..  

(D) É um sistema construtivo racionalizado, no qual os 
elementos que desempenham a função estrutural 
são de alvenaria, ou seja, os próprios blocos de 
concreto.  

(E) O sistema construtivo é executado com placas de 
gesso parafusadas em uma estrutura de aço 
galvanizado, compostas por um miolo de gesso e 
aditivos, envolto por cartão especial. A soma desses 
elementos, resistentes a esforços de compressão, 
resultam em uma superfície de revestimento ideal 
para acabamento.  

 
 

64. Considerando o Zoneamento Bioclimático Brasileiro e as 
diretrizes construtivas para habitações unifamiliares de 
interesse social, assinale a alternativa que apresenta o 
tipo de cobertura adequada para a Zona Bioclimática 
Brasileira – Zona 7 – indicada na figura abaixo. 

 

 
 

(A) Cobertura de telha de barro com laje de concreto de 
20cm ou 25cm. 

(B) Cobertura leve isolada com pequenas aberturas 
entre forro e cobertura.  

(C) Cobertura de telha de barro ou fibrocimento com 
forro de concreto (espessura = 3cm).  

(D) Cobertura de telha de fibrocimento + forro de 
madeira.  

(E) Cobertura de telha de fibrocimento + lâmina de 
alumínio polido e forro de madeira.  

65. Assinale a alternativa que não atende às diretrizes para 
projetos de áreas públicas urbanas no que se refere às 
condições de acessibilidade – procedimentos para garantir 
que a interligação entre equipamentos públicos, 
condomínios e habitações unifamiliares se faça por meio 
de percursos acessíveis a todos os usuários. 

 
(A) Passeios e rampas devem ter, no mínimo, 1,2m de 

largura livre e desimpedida, salvo legislação ou 
norma mais restritiva.  

(B) Adotar faixas de travessia elevada ou outros 
redutores de velocidade, principalmente nas vias 
locais. 

(C) Mobiliários públicos (pontos de ônibus, caixas de 
correio, telefones públicos, lixeiras, postes de 
iluminação), nas calçadas, devem ter locação 
adequada, sem obstruir a faixa livre de circulação de 
pedestres. 

(D) As travessias devem ter guias rebaixadas, 
localizadas em pontos da calçada para a fruição 
segura do pedestre, de forma que ele possa 
visualizar adequadamente o tráfego de veículos, 
sobretudo nas vias coletoras e estruturais. 

(E) Calçadas com largura superior a 1,50m devem 
prever linhas-guia. Devem, também, oferecer acesso 
a áreas verdes e a sistemas de lazer. 

 
 

66. Sobre os conceitos quanto à morfologia urbana, marque V 
para verdadeiro ou F para falso e, em seguida, assinale a 
alternativa que apresenta a sequência correta. 

 
(...) A morfologia é o estudo da forma da cidade, 

consistindo no seu padrão de arruamento, tamanho 
e forma dos prédios, densidade populacional e usos 
(residencial, comercial e industrial). 

(...) A morfologia estuda os aspectos exteriores do meio 
urbano e as suas relações recíprocas, determinando 
e interpretando a paisagem urbana e a sua 
estrutura. 

(...) Um estudo morfológico é feito do conjunto de 
elementos sociais, econômicos e urbanos. Estes são 
utilizados para a explicação da produção da forma e 
da cidade como elemento físico e construído. 

(...) O estudo da morfologia urbana objetiva a 
organização do espaço urbano e suas relações para 
compreender a formação, a evolução e a 
transformação do espaço urbano e de seus 
elementos, e suas relações, possibilitando a 
identificação de formas mais apropriadas para a 
intervenção na cidade e o desenho de novas áreas. 

 
(A) V/ V/ V/ V 

(B) V/ V/ F/ V 

(C) V/ V/ V/ F 

(D) F/ F/ F/ V 

(E) F/ V/ V/ F 
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67. Considere que um projeto viário compreende o estudo e a 
formulação de propostas para assegurar bom 
desempenho da malha viária em consonância com as 
diretrizes do processo de planejamento. Neste sentido, em 
um projeto executivo, é correto afirmar que os 
componentes de um projeto viário são: 

 
(A) plano de circulação urbana; projeto geométrico; 

projeto de sinalização estratigráfica; projeto de 
sinalização semafórica e projeto de sinalização 
informativa. 

(B) planejamento urbano físico-territorial e plano de 
intervenções no espaço urbano fundamentados nos 
sistemas de infraestrutura, transportes, sistema 
viário, tráfego e trânsito, sinalização e 
acessibilidade, todos inter-relacionados ao traçado e 
dinâmicas da cidade em seu âmbito urbano.  

(C) representação em planta dos pontos notáveis, assim 
como dos acidentes geográficos e outros 
pormenores de relevo de uma via e seu entorno.  

(D) proposta de circulação, raios de giros veiculares e 
velocidades, devendo considerar: ilhas de 
canalização e refúgios para pedestres; implantação/ 
adequação de canteiro central, alterações/ correções 
de alinhamentos viários; especificações de meios-
fios; facilidades para pessoas portadoras de 
deficiência (acessibilidade); indicação de tratamento 
de possíveis interferências com redes de serviços 
públicos existentes; implantação de dispositivos de 
canalização de pedestres.  

(E) especificação dos materiais de revestimentos das 
calçadas; especificação dos materiais das pistas de 
rolamento; serviços de terraplenagem, drenagem, 
pavimentação; medidas moderadoras de tráfego; 
bases e redes necessárias à implantação de 
sinalização vertical e semafórica.  

 
 

68. Com relação à elaboração de um orçamento de uma 
cobertura de uma obra, assinale a alternativa que 
apresenta como é efetuada a medição referente aos 
serviços técnico-profissionais decorrentes do fornecimento 
dos materiais, ferramentas e mão de obra necessários à 
colocação das telhas, incluindo acessórios de fixação, 
fixação na estrutura do telhado, andaimes, limpeza e 
demais serviços auxiliares para a perfeita instalação. 

 
(A) A medição será efetuada por preço global.  

(B) A medição será efetuada por meio das dimensões 
indicadas no projeto, em metro linear, devendo ser 
arredondadas para mais, em múltiplos de 0,05m.  

(C) A medição será efetuada pelo volume das peças 
colocadas e mão de obra em m³.  

(D) A medição será efetuada pela área de projeção da 
cobertura no plano horizontal, conforme projeto, em 
m².  

(E) A medição será efetuada por metro linear de peça 
instalada, conforme as dimensões indicadas no 
projeto.  

 
 
 
 
 

69. Considerando o correto uso de escalas gráficas na 
representação de projetos de instalações hidráulicas e 
sanitárias, leia o texto abaixo e, em seguida, assinale a 
alternativa que preenche correta e respectivamente as 
lacunas. 

 
Os produtos gráficos que compõem o projeto de 

instalação de esgoto sanitário correspondem à: 

– Planta de situação ao nível da rua, _____________, 

indicando a localização de todas as tubulações externas e as 

redes existentes das concessionárias e demais equipamentos 

de interesse, com a indicação de cortes e detalhes e com 

indicação das áreas a serem ampliadas ou detalhadas, quando 

for o caso;  

– Planta baixa de cada pavimento da edificação, 

____________, contendo caminhamento e indicação das 

tubulações quanto a material, diâmetro e à elevação, 

localização precisa dos aparelhos sanitários, ralos e caixas 

sifonadas, peças e caixas de inspeção, tubos de ventilação, 

caixas coletoras e instalações de bombas, se houver, caixas 

separadoras e outros;  

– Plantas dos conjuntos de sanitários ou ambientes com 

despejos de água, ___________, com detalhamento das 

instalações. 

 
(A) escala mínima de 1:500/ em escala 1:50/ em escala 

1:20 

(B) escala mínima de 1:200/ em escala 1:500/ em 
escala 1:10 

(C) escala mínima de 1:100/ em escala 1:100/ em 
escala 1:20 

(D) escala mínima de 1:20/ em escala 1:200/ em escala 
1:50 

(E) escala mínima de 1:50/ em escala 1:20/ em escala 
1:1 
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70. Sobre os conceitos e a normatização sobre sistema de 
aterramento SPDA (Sistema de Proteção contra Descarga 
Atmosférica) para raios, marque V para verdadeiro ou F 
para falso e, em seguida, assinale a alternativa que 
apresenta a sequência correta. 

 
(...) No projeto do SPDA, calhas e tubos de águas 

pluviais podem servir como meio de instalação de 
condutores de descida. 

(...) No projeto do SPDA, deverá ser efetuada a 
equalização de potencial, interligando o SPDA, a 
armação metálica da estrutura, as instalações 
metálicas, as massas e o sistema elétrico, eletrônico 
e de telecomunicações dentro do espaço a proteger. 

(...) Do ponto de vista da proteção contra o raio, um 
subsistema de aterramento único integrado à 
estrutura é preferível e adequado para todas as 
finalidades (proteção contra o raio, sistemas de 
potência de baixa tensão e sistemas de sinal). 

(...) Nos prédios de concreto armado, poderão ser 
usados como condutores de descida os ferros de 
armação, desde que seja garantida a continuidade 
elétrica nas emendas e que tenham, pelo menos, 
3mm de diâmetro.  

 
(A) V/ V/ V/ V 

(B) V/ V/ F/ V 

(C) V/ V/ V/ F 

(D) F/ F/ F/ V 

(E) F/ V/ V/ F 
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